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1 Introduction 

1.1 What is the scope of this document and how does it relate to other available documentation? 

This guide covers use of Loki Provisioning for element provisioning. The target audience is the 

administrators who deal with an operator’s provisioning and customer care functions.  

The Loki Provisioning Admin Guide covers the set up and system configuration of Loki Provisioning.  

Note: Loki Provisioning has a sibling application, Loki Portals, which offers service configuration.  

 

1.2 What is Loki Provisioning™? 

Loki is an element provisioning platform designed for communications service providers. At its core it does 

three primary things:  

a) Automation 

Loki Provisioning drastically reduces the number of steps and inputs required to create best practice 

subscriber configurations. In terms of time spent, we typically see improvements of 10x for smaller 

customer deployments and as much as 20x for larger ones.  

b) Standardization 

VoIP configurations can be complicated and it’s important to make sure you’ve got best practice 

standards in place. The downside of not configuring against a standard is that post-sales support costs 

are substantially higher and it is hard to bring on new installers.  

c) Access Management 

If you have employees with different functions, for example, provisioning, field deployment, and 

customer care, you may wish to provide different levels of access to each function to reduce the risk of 

security issues and provisioning operations that break your standard workflow.  

Users interact with Loki through a web 
interface. Loki also offers an web services API 
which simplifies integration between upstream 
OSS/CRM/BPM systems and your VoIP 
elements. Loki provides service providers best 
practice subscriber management capabilities. 
It is not itself a CRM system- for example, Loki 
does not have its own subscriber database

1
. 

Loki pulls data from the service provider’s 
various VoIP subsystems in real time. 

 

                                                           
1
 For CRM and business process management, we offer Loki BPM. See www.leonidconsulting.com for more details.  

http://www.leonidconsulting.com/
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1.3 What does Loki Provisioning™ do? 

Loki capabilities include: 

 Automated Enterprise, Group, and User provisioning in the BroadWorks application suite 

 Device provisioning & configuration 

 Service level provisioning 

 TN management (including ports & swap’s) 

 Welcome Email delivery 

 Automated order form (station review) processing  

 Subscriber add wizard: web-based bulk add interface 

 Device MAC update facility for just in time device deployment 

 Bulk update facility for Group-wide changes subscriber attributes 

 Customer Service/Tech Support Troubleshooting interface  

 Additional elements 
o Messaging account provisioning  

 via 3
rd

 party script 
o Sonus PSX provisioning 
o Genband SBC provisioning 

 

1.3.1 What does Loki Provisioning not include that I’ll need to do? 

There are a couple of items where we provide examples and guidance, but are not part of the actual Loki 
Provisioning software. The first is the Excel-based site survey. We provide a reference survey with Loki 
Provisioning, but it’s for the customer to tailor the site survey to their particular needs. You’ll want someone who’s 
familiar with formulas in Microsoft Excel to do this.  

On BroadWorks message store, it’s the customers responsibility to provide an interface for Loki Provisioning to 
call to create mailboxes. Details on the requirements for this are the Loki Provisioning Admin Guide. You’ll want 
someone that’s familiar with scripting in Unix/Linux to do this. Note: if you use Surgemail, Loki Provisioning does 
have a standard interface to that application.  

 

1.4 How does Loki Provisioning relate to Loki Portals? 

Loki Provisioning deals with entities and configurations that are normally established by your core 
provisioning and care teams. Most of these items have direct bearing on your billing and our call routing. 
Loki Portals allows for more detailed configurations of subscriber entities that do not have commercial 
impacts and that are often completed by the customers themselves, often with the assistance of a 
field/sales engineering team. For example, in Loki Provisioning you could create a new Auto Attendant for 
a Group and give it a phone number. In Loki Portals, you or the customer would then be able to configure 
the options on the Auto Attendant: how the different options route, time of day menus, etc.  
 



 

 

PROPRIETARY & CONFIDENTIAL  7 of 52 

 

1.5 How does Loki Provisioning work? 

At a high level, a typical Loki transaction works as follows:  

 

At a more detailed level, the following diagram provides an example of how Loki works in a web service context 
with an existing CRM: 

 

Note: the site survey is available for download from the application. See link on the top right of the screen. 

  

1.6 What network elements can Loki Provisioning manage? 

Currently, Loki Provisioning has interfaces to the following subsystems:  
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 BroadWorks AS 

 Messaging (for BroadWorks) 
o by way of 3

rd
 party scripts and interfaces 

 Sonus PSX 

 Genband SBC  
 
Loki Provisioning is built on a flexible plug-in framework and can accommodate a variety of systems. 
 
 

1.7 What functions does Loki Provisioning offer? 

Loki has three primary tabs- Enterprise (also covers Service Provider), Group, and Users. The tables below 
describe Loki Provisioning’s functions in three separate sections corresponding to those three tabs.  Each tab has 
four sub-areas: Add, View, Modify and Delete.  
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1.7.1 Enterprise 

Area Item Notes 

Add 

Admin 
add an Enterprise (or Service Provider) 
admin 

Enterprise add a new Enterprise (or Service Provider) 

Numbers 

add numbers to the enterprise 

note: it is not necessary to pre-provision 
numbers down to the Group for user add’s; 
Loki will dynamically add selected numbers 
on users 

Enterprise Trunk add an enterprise trunk 

View 

Numbers view numbers  within the Enterprise  

Service Authorizations 
view service authorizations within the 
Enterprise 

Service Pack Consumption 
view Service Pack consumption within the 
Enterprise 

Modify 

Admin modify an Enterprise admin 

Enterprise Trunk modify an Enterprise Trunk 

Reconcile Voice VPN 
update the Enterprise’s voiceVPN settings 
from the Loki Helper template (see later 
sections on templating) 

Routing Profile update the selected Routing Profile 

Service Authorization update service authorizations 

Voice VPN modify the voiceVPN settings 

Delete 

Admin delete an Enterprise Admin 

Enterprise delete an Enterprise 

Numbers delete numbers from an Enterprise 

Service Packs delete Service Packs from an Enterprise 

Enterprise Trunk delete an Enterprise Trunk 
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1.7.2 Group 

Area Item Notes 

Add 

Admin add a Group Admin 

Device 

add a Group Device  

note: it’s not necessary to pre-add devices 
here; Loki will add new devices on the fly 
during the user add routine 

Group add a new Group 

Numbers 

add numbers at the Group level 

note: it is not necessary to pre-add these 
prior to User add 

Group Services: Auto Attendant, 
BroadWorks Anywhere, Call 
Capacity Management, Call 
Center, Hunt Group, Instant Group 
Call,  Trunk Group 

add various Group service instances 

View 

Numbers view numbers assigned to the Group 

Profile view the Group’s profile 

Services view services assigned to the Group 

Modify 

Admin  

Device  

Profile  

Reconcile Service Packs  

Routing Profile  

Service Assignments  

Service Authorizations  

Call Processing Policies  

Activate Numbers  

Group Services: Auto 
Attendandant, BroadWorks 
Anywhere, Call Capacity 
Management, Call Center, 
Emergency Zones, Hunt Group, 
Instant Group Call, Intercept 
Group, Preferred Carrier Group, 
Trunk Group, Voice Portals 

modify the aforementioned Group services 

note: these are only modifications that 
pertain to billable items or (in a typical 
deployment) orchestrated changes like 
CLID; other configuration type changes 
would be made in Loki Portals or the native 
BroadWorks GUI 

Delete 

Admin delete a Group admin 

Department delete a Dept. 

Device delete a device 

Group  delete a Group 

Numbers delete Numbers 
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Group Services: Auto Attendant, 
BroadWorks Anywhere, Call 
Capacity Management, Call 
Center, Hunt Group, Instant Group 
Call,  Trunk Group 

delete said service instances 

 

1.7.3 User 

Area Item Notes 

Add 

by Site Survey 
this allows the user to bulk add users from a 
site survey 

by Wizard 
this allows the suer to bulk add users 
through a step-wise wizard 

Modify 

User Modify 
this allows for modification of user 
parameters like userID, service 
assignments, and phone number 

Troubleshooting 
this provides a simplified dashboard for 
reviewing the status of individual user 
accounts 

Number Swap 
this allows for the swapping in of 
permanents numbers (see section below on 
TN Management routine- ‘port with temp’) 

MAC Update 
this provides a consolidated pages for 
updating MAC addresses 

Parameters Maintenance 
this provides for the bulk updating of 
various user and user service configurations 

Intercept User 
this allows for the modification of this 
service  

Delete Users allows for the deletion of users 
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1 Navigation 

1.1 How do I get around Loki? 

There are two major sections to Loki 2.3’s navigation: the “supernav” which allows you to select customer entities 
(Enterprises, Groups, Users, etc.) and then the tabular navigation which organizes all the functions.  
 

 
 
The items in the supernav map to the BroadWorks hierarchy: Cluster (if you have multiple AS clusters), 
Enterprise (or Service Provider), Group, and User. Note: you can select an individual User as soon as you 
select an Enterprise. You can also user the Search function if you want to find a particular item:  
 

 
 
Note: the search uses the “*” as a wildcard. So if you wanted to find all Users with a number starting with 
415377 you’d enter “415377*” in the phone number field in search.  
 
The tabular navigation is also organized around the BroadWorks hierarchy. You have tabs for each major 
level, and then Add, View, Modify, and Delete buttons with actual functions under them. For example, if you 
wanted to add a User/s, you’d go to the Users tab, select the Add button, and then you’d see options for 
adding (site survey or wizard).  
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2 Workflow 

2.1 What are the key entities in BroadWorks and how are they managed? 

First, BroadWorks has a strict hierarchy to enable multi-tenant operation and self-care. The labels on the far left of 
the diagram below describe this hierarchy. At the top level is the System, then Enterprises and Service Providers, 
which are at the same level of hierarchy but have different properties. While Loki supports various uses of this 
hierarchy, for operators that sell to business, usually an Enterprise represents a unique customer, Joe’s Subs, for 
example. The next level is the Group. The Group almost always represents a single physical site Joe’s Subs on 
Eight St., for example. Next we have the Department. If you want to create functional divisions within a Group, you 
can use Departments. Finally at the bottom of the hierarchy are the Users themselves.  

 

Next we have Services. It’s worth noting here that there are two types of services in the system: Group Services 
like Auto Attendant and Hunt Group and Users Services like Call Forward. At the top level of the hierarchy, your 
system has a license and that license allows you a certain amount of these various services across the whole 
system. Next, Services are “authorized” at the Enterprise and Service Provider level. Authorizations are per 
service and can be either unlimited or limited to a fixed quantity. All resources in BroadWorks are strictly 
hierarchical so every Service you want to assign within a Group has to be then authorized at the Group level. 
Group Services are then assigned directly to the Group. User Services are assigned to Users. In Loki, Services are 
assigned through templates, user add routines, and direct modification.  

Service Packs are administrator-defined sets of User Services, useful for organizing the assignment of bundles 
(packs) of Services to Users.. These are created at the Enterprise or Service Provider level. There is no native 
system-level concept of a Service Pack in BroadWorks. However, we enable a system Level definition in Loki 
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through the use of templates (see following section on templates). Services Packs are then authorized at the 
Group level and then assigned to Users. There is currently no such thing in BroadWorks as a Service Pack for 
Group Services, though we enable this functionality in Loki through templates. 

Phone Numbers (TN’s) are created at the Enterprise or Service Provider level. There is no system repository of 
TN’s on the BroadSoft AS. Phone numbers available in an Enterprise or Service Provider can then be assigned 
out to its various Groups. Now the phone numbers are available to assign at the Group level to Group Services 
that use TN’s (like Auto Attendant) and also down at the User level to individual users.  

Finally, we have devices. Group Devices are devices like IAD’s that have multiple Users assigned to them in 

BroadWorks. These are created at the Group level either through the Group Add routine or by hand at the Group 

menu. User Devices are also available across the Group, but are generally user-by-user (one user per phone). 

These are created during the User Add routines or through the User Modify menu’s. 

 

2.2 What is the end to end workflow for a typical new customer add?  

The diagram below describes a typical workflow:  

 

Enterprise and Group provisioning are executed through an interactive web interface on Loki. Users can be 
created either by way of automated site survey upload or Loki’s web-based subscriber creation wizard. 
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2.3 What are the key entities in Sonus and how are they managed? 

The following diagram describes the general data model between the BroadWorks and the Sonus GSX/PSX:  

 

The integral element between BroadWorks and Sonus is the TN (telephone number). The Sonus GSX is a 
gateway element, providing transit. The PSX (policy server) controls call routing. The PSX contains three tables 
that are relevant from a provisioning standpoint. The following subsections describe these tables with regard to:  

 Name: names the parameter 

 Type: the data type 

 Value: the value required for said parameter. If the entry is surrounded by <> then this means it is an 
input.  

 Example: an example value 

Certain values are supplied in the plug-in configuration as defaults- these are designated as <Static>, and certain 
values may be supplied by the user.  

 

The Wizard Survey Screen is where the user configures the details on various TN’s. In the case of Sonus, the 
following parameters should be available for specification by the user:  

 General Provisioning 

o Booleans should be exposed when the Sonus interface is enabled for the Tables 

 Subscriber 

 Destination 

 Route 

o . . . indicating whether or not these various tables should have new entities added.  
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 Subscriber Table 

o interLataCarrierId 

o intraLataCarrierId  

o intlCarrierId  

o billingPlanId 

o localCarrierId 

o presentationFlag (“presentation”) 

o origEntityRoutingProfileId 

o callingArea 

o authcodeScriptId 

o exceptionProfileId 

o classOfServiceId 

 Destination Table 

o elementAttributes (“CNAM”) 

o portedType  

o homeGateway 

 Route 

o partition list 
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Note: the following parameters must be available (in free text) via the Control Form for bulk update:  

 billingPlanId 

 homeGateway 

  callingArea 

note: Sonus add’s are not currently supported by the site survey upload.  

 

The following rules apply to the management of Sonus entities:  

2.3.1 Validation Prior to Provisioning of Services 

For Each TN to Add (based on indicated tables): 

a. If add’s to the Destination Table are indicated and If an entry for this TN exists in the Destination 
table, return an error 

b. If add’s to the Subscriber Table are indicated and If an entry for this TN exists in the Subscriber 
table, return an error 

c. If add’s to the Route Table are indicated and If an entry for any matching  {TN, partition} exists in 
the Route table, return an error 

 

2.3.2 Add’s 

On add, the following steps are performed:  

 based on the value of the defaults/indicated check boxes 

o add all entries in the Subscriber Table per Model section above with static or configured inputs 

o add all entries in Destination Table to all applicable (selected) partitions 

o build entries in the Route Table based on the static or configured partition list 

 

2.3.3 Modify 

On modify, execute the following steps:  

 Check for entries in the Standard Route table (all partitions) 

 Check for entries in the Destination table 

 Check for entries in the Subscriber table 

 Present the same view described in the applicable View section above 

 On save, execute an add, delete, or modify as noted above.  

 

2.3.4 Delete’s 

On delete, execute the following steps:  

 In the Standard Route Table, delete entry for TN each of the statically configured partitions or OMI-
returned partitions  

a. if no TN is found in a given partition, returning a warning 
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 In the Subscriber Table, delete entry 

 In the Destination Table,  mark the number as ported out  

 

 

2.3.5 Rollback (General) 

If there is a failure anywhere in the workflow, the Sonus provisioning should roll back.  
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2.4 How does Loki™ do service management? 

Loki manages services by way of templates- sets of standard configurations that are applied to new Groups. This 
system ensures consistency and automates many time consuming tasks such as creating Service Packs, setting 
admin rights, and configuring calling plans, among others. The templates Loki uses are created inside 
BroadWorks itself in a dedicated Service Provider called “LokiHelper” that Loki uses for configuration (Loki is 
made aware of this Service Provider’s identity in its configuration file). This Leonid proprietary approach has 
several advantages:  

1. it avoids the need to train maintenance staff in yet another interface- just use BroadWorks itself, which 
you already know how to use 

2. it greatly alleviates the requirements for updates to Loki during release upgrades- new services are 
instantly available in the template for assignment 

3. it creates a single global repository for configuration information 

The figure below provides an overview of the Service Provider construct:  
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The following screen shot shows a Group add through Loki:  

 

As notes on the screen shot, there is a list of available templates, and these correspond to the Groups in the Loki 
dedicated Service Provider.  

The following steps are taken for service management when a new Group is created:  

1. a template is selected by the user 

2. the following items are retrieved from the template Group in the LokiHelper Service Provider (in real time 
every time a new Group is created) 

a. authorized Service Packs 

b. Group service authorizations 

c. Feature Access Codes 

d. Group Admin rights settings 

e. Outgoing Calling Plan settings 

3. the new Group is created 

4. the template is applied to the new Group 

a. all Service Packs that were authorized to the Group Template Group are created in the new 
Group’s Enterprise and then authorized to the new Group created 

b. all Group Services authorized in the Group Template Group are authorized in the new Group’s 
Enterprise and then assigned to the new Group created 

c. the new Group’s Feature Access Codes are set to match those of the Group Template Group 

d. the new Group’s Group Admin Rights are set to match those of the Group Template Group 

e. the new Group’s Outgoing Calling Plan settings are set to match those of the Group Template 
Group 
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2.5 How does Loki™ do TN (telephone number) management? 

Loki exports five TN management routines. TN management routine refers to a pre-defined deterministic process 
for acquiring TN’s to use in for a user or virtual user in BroadWorks. These TN routines are generally available for 
both virtual users/Group Services created during the Group add as well as individual users. In the case of virtual 
users/Group Services the routines are specified in a drop down associated with the service, Trunk Group, for 
instance. In the case of users, they are specified on the site survey or web-based bulk add wizard.  

 

The following table describes the TN management routines:  

TN Routine Use When… User Inputs TN’s Must Be… Description 

(none)/blank 
you don’t need 
TN management 

the TN you want 
to use 

n/a 

The TN’s are expected to be 
already assigned and available 
in the Group. If they are not the 
system will error with cause. 

1. port but 
needs temp 

you are porting 
in and want to 
bring the user 
online without 
interfering with 
normal calling to 
the TN 

the permanent 
TN/TN that you 
are porting in  

the permanent 
number must not 
assigned anywhere 
in the system; there 
must be inventory 
available for the 
temporary number 

The new ported-in TN is added 
to the Group, as  is a temporary 
TN to use for routing. The 
permanent TN is used all 
places where the TN is 
normally used (UserID, SIP auth 
username, linePort/SIP URI, 
etc.). The temporary TN is 
assigned as the TN. When a 
swap is later executed by Loki 
the temporary TN is returned to 
inventory and the permanent 
TN added. 

2. port no 
temp 

you need to add 
a new number to 
the system and 
assign it to the 
user 

the TN you want 
to use 

not assigned 
anywhere in the 
system (see 
description) 

The new TN is added to the 
target Group. On user add, If 
TN is already assigned to the 
group and is available, Loki will 
automatically use the 
(none)/blank TN routine.  

3. new 
number 
(any) 

you want any 
number/any 
number in a 
certain NPA or 
NPANXX from 
your inventory 

the NPA, 
NPANXX or 
general prefix 
you want to find 
in inventory (or 
blank if you do 
not have a 
preference) 

assigned and 
available in the 
LokiHelper Service 
Provider 

A TN is selected from the 
LokiHelper, removed, and 
added to the target Group. 

4. new 
number 
(reserved) 

you have a 
number in your 
inventory you’re 
reserved for the 
customer 

the TN you want 
to use 

assigned and 
available in the 
Group “TN 
Reservoir” in the 
LokiHelper Service 
Provider 

The TN is located in the TN 
Reservoir Group within 
LokiHelper, removed, and 
added to the target Group. 
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5. no 
number 

the user is just 
going to have an 
extension 

blank n/a No TN is added to the account. 

 

3 System Functions 

3.1 What is the overall function space available from Loki Provisioning? 

The following table shows the command space available via Loki Provisioning 2.3 down the BroadWorks 
hierarchy:  

 

 

Tab Button Button Item Function Functional Block Notes

System

Profiles add, modify, and delete access profiles 1: Add, Modify, Delete Admin's and 

Profiles

Admins here the admin will add, modify, delete 

admin's, including association to 

Profiles

1: Add, Modify, Delete Admin's and 

Profiles

Tab Button Button Item Function Functional Block Notes

Enterprise

Add

New Enterprise create a new Enterprise 2: Add, Modify, Delete Billable Entities

Admin create a new Enterprise admin 2: Add, Modify, Delete Billable Entities

TN's add TN's to the Enterprise 2: Add, Modify, Delete Billable Entities

View

Services Shows services assigned to the Group (any)

Service 

Authorizations

Shows service authorizations and link 

to service pack details

(any)

Service Packs Shows service pack details (any)

Service Pack 

Consumption

Shows service pack consumption per-

Group

(any)

Modify

voiceVPN modify voiceVPN settings 6: Routing and Translations

Service Packs allows changing name and description

Service 

Authorizations

modify Enterprise level Service 

Authorizations

2: Add, Modify, Delete Billable Entities

Admin allows for modification of admins 

(name, password)

(9) Create Virtual PBX Admin's

Delete

Enterprise allows for the deletion of an Enterprise 

(must delete Groups)

2: Add, Modify, Delete Billable Entities

Service Packs allows for the deletion of Service Packs

Admin allows for deletion of Enterprise 

administartors

2: Add, Modify, Delete Billable Entities

TN's allows for removal of TN's 2: Add, Modify, Delete Billable Entities
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Tab Button Button Item Function Functional Block Notes

Group

Add

New Group allows for the addition of a new Group 

using templates for service 

management and configuration

2: Add, Modify, Delete Billable Entities note: must also have 4: Add 

TN's, Remove TN's to add 

virtual users during add

New Department create new department 2: Add, Modify, Delete Billable Entities

Shared Device create new shared device 2: Add, Modify, Delete Billable Entities

TN's add TN's to the Group (may add 

directly)

4: Add TN's, Remove TN's

Virtual Users (one 

menu item for each 

vUser group service 

including Trunk 

Group)

allows for adding new instances of 

virtual users

2: Add, Modify, Delete Billable Entities must have 4: Add TN's, 

Remove TN's to add with 

new/non-existing TN

Other Services links to Loki Portals to allow for adding 

of non-virtual user group service 

instances (e.g. Call Park, etc)

(any)

Admin create new Group admin 2: Add, Modify, Delete Billable Entities

View

Services Shows services assigned to the Group (any)

Service 

Authorizations

Shows service and service pack 

authorizations and link to service pack 

details

(any)

Modify

Modify Group allows for update of profile and virtual 

Users

7: Site Troubleshooting

Service 

Authorizations

allows for updating these quantities 2: Add, Modify, Delete Billable Entities

Service 

Assignments

allows for updating of these 

assignments

2: Add, Modify, Delete Billable Entities

Reconcile Service 

Packs

allows for addition of any missing 

service packs defined in the Loki Helper 

Service Provider

2: Add, Modify, Delete Billable Entities

Virtual Users (one 

menu item for each 

vUser group 

service)

allows for modifying Loki-controlled 

parameters of virtual users, and links to 

LokiPortals for detailed settings

2: Add, Modify, Delete Billable Entities

Delete

Group remove the Group 2: Add, Modify, Delete Billable Entities

Department remove the Department 2: Add, Modify, Delete Billable Entities

Trunk Group remove the TG 2: Add, Modify, Delete Billable Entities

Shared Device remove the device 2: Add, Modify, Delete Billable Entities

TN's remove TN's (may remove from system) 4: Add TN's, Remove TN's

Virtual Users

(one menu item for 

each vUser group 

service)

delete virtual users 2: Add, Modify, Delete Billable Entities

Admin remove admin's 2: Add, Modify, Delete Billable Entities
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Note: creating profiles and admins is described in the Loki Provisioning Admin Guide.  

 

 

 

 

 

  

 

Tab Button Button Item Function Functional Block Notes

User

Add

by Site Survey site survey upload and subsequent 

workflow

3: Add Users and Devices

by Wizard wizard and subsequent workflow 3: Add Users and Devices

Modify

User Modify general maintenance page of User 3: Add Users and Devices

Troubleshooting updated troubleshooting page 5: Configure Entities and User 

Troubleshooting

Number Swap swap for TN routine 1 4: Add TN's, Remove TN's

MAC Update update page 3: Add Users and Devices

Parameters Maint. bulk updates 5: Configure Entities and User 

Troubleshooting

Delete

Users allows for bulk update 2: Add, Modify, Delete Billable Entities
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4 Enterprise 

4.1 How do I add an Enterprise? 

Enterprises are added through Loki’s interactive web interface. The following is a screen shot of the add 
Enterprise screen:  

 

Just select an ID, Name and domain.  

4.2 How do I add an admin at the Enterprise level? 

From the screen shot above, simply select “Admin” and enter a username and password. 
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4.3 How do I add Numbers at the Enterprise level? 

From the Add menu, just select Numbers:  

 

Then you can either enter a range or individual number in 10 digit format, and you can add a list.  

Note: it is not necessary to add TN’s at the Enterprise level unless you either:  

a) want to store them there 

b) will have admin’s doing User Add’s that don’t have rights to add TN’s 

An admin with full rights can add TN’s to the system during the various User add routines (see section on User 
below).  
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4.4 How do I modify the voiceVPN settings for the Enterprise? 

From the Modify button under the Enterprise tab, select voiceVPN:  

 

You can then add modify, or delete the individual voiceVPN rules.  
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4.5 How do I modify service authorizations for the Enterprise? 

Note: it is not necessary to restrict or modify service authorizations at the Enterprise level unless you want to 
allow admin’s at lower levels who don’t have the right to modify authorization levels to add entities.  An admin 
with full rights can add services to the system during the various Group and User add routines (see section on 
Group and User below).  

 

4.6 How do I delete an Enterprise? 

Note: you must first delete all Groups in the Enterprise. Then just go to the Delete button under the Enterprise tab. 
You’ll see a list of Enterprises and you can select Enterprises for deletion. 

 

4.7 How do I delete an Enterprise admin? 

To delete an Enterprise Admin, you select an Enterprise, then select the Delete button and Admin option:  

 

4.8 How do I delete Numbers from the Enterprise? 

Note: it is not generally necessary to do this as the User and Group delete routines allow for the complete 
removal of TN’s from the system. 

If you want to delete numbers from the Enterprise, just select Numbers from under the Delete button under the 
Enterprise tab. 
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5 Group 

5.1 How do I add a Group? 

Groups are added through Loki’s interactive web interface. To add a Group navigate to the Group tab and the 
Add button.  

The following is a screen shot of the add Group screen:  

 

There are several subsections to the items for the Group Add as follows:  

5.1.1 Profile  

These inputs are all optional. 

5.1.2 Template 

The template you select controls configuration and service management for your new group.  Section 2.3 
described Service Management in Loki. The following steps are taken for service management when a new 
Group is created:  

1. a template is selected by the user (see Intro section for an explanation of templates) 

2. the following items are retrieved from the template Group in the (in real time every time a new Group is 
created) 

a. Service authorizations on Enterprise (sys admin only) 

b. Create service packs in Enterprise (sys admin only) 

c. Group's services and service packs authorizations 

i. if the service pack did not exist at the Enterprise of Service Provider level, it is created 
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d. Group's services assignments 

e. Group's Web policy settings 

f. Group Preferred Carrier 

g. Feature access codes 

h. 3rd-party Voice Mail Support settings (if supported & enabled in Loki) 

i. Outgoing Calling Plan settings 

j. Holiday Schedules 

k. Time Schedules 

l. if Group Admins created, policies copied from template admins (for Ent/SP level, template 
admins are admins located in template group 

5.1.3 Group ID/Name 

Generally the ID comes from your upstream CRM/BPM/OSS system and the Name is a descriptive name. 

5.1.4 Group Calling Name 

This is technically optional but note that extension dialing will not work without this (you do not have to check 
either of the options for it to work). 

5.1.5 Group Admin 

You can optionally create a Group Admin at this point and specify a password. Click the “add 2
nd

 admin” link to 
add another. 

5.1.6 Group Device 

You’ll need to create one of these if you’re doing either business trunking or business line. Note: the list of 
available device types comes from the approved list in your global Loki configuration.  

5.1.7 Trunk Group 

You’ll need to create one of these if you’re doing either business trunking or business line. Note: the list of 
available device types comes from the approved list in your global Loki configuration. 

5.1.8 Trunk Unavailable and Bursting 

These are optional trunk group parameters.  

5.1.9 Departments 

Departments allows you to subdivide Users at the Group level. You might do this if you want to make certain 
services only available to a certain Department, or create a Department admin. 

5.1.10 Voice Portal 

This allows you to create the voice portal. 
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5.2 How do I add a Department? 

Just navigate to the Add button under the Group tab, select Department and give the Dept. a name:  

 

 

5.3 How do I add a Trunk Group? 

To add a Trunk Group, you select a Group, then select the Add button and Trunk Group option:  
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5.4 How do I add a Shared Device? 

To add a Group device, you select a Group, then select the Add button and Shared Device option:  

 

 

5.5 How do I add a Virtual User? 

You can create new instances of Group Services with the following parameters:  

 phone number 

 calling line ID 

 service assignment (optional) 

Some other services have additional parameters. 

Detailed modification of these services’ parameters would be performed in Loki Portals.  

The following services are be supported:  

 Auto Attendant 

 Call Center 

 Instant Conferencing 

 Hunt Group 

 Instant Group Call 

 Voice Portal 

 BroadWorks Anywhere Group Portal 
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To add a Virtual User, select a Group in the super navigation, click the Group tab, the Add button, and then  select 
the service of interest:  

 

When adding a Virtual User, just fill out the necessary parameters and click submit. These generally have three 
main sections: Phone Number, Profile, and Assign Services: 
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5.6 How do I add a Group admin? 

To add a Group admin, you select a Group, then select the Add button and Admin option:  
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5.7 How do I modify a Virtual User? 

To modify a Virtual User, just select Modify under the Group tab, select the type of Virtual User, then you’ll need 
to select from the available instances. The following screen, for example, is for modification of an Auto Attendant:  

 

 

5.8 How do I modify service authorizations for the Group? 

Note: it is not necessary to restrict or modify service authorizations at the Group level unless you want to allow 
admin’s at lower levels who don’t have the right to modify authorization levels to add entities.  An admin with full 
rights can add services to the system during the various User add routines (see section on User below).  
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5.9 How do I add new Service Packs to a Group? 

As we described in the Group Add section, Loki uses templates to manage Service Packs. You can update your 
Group’s Service Packs by going to Group > Modify > Reconcile Service Packs. You’ll need to select the template 
you want to reconcile against, and off you go; the following screen is an example of the success page (where the 
Service Pack “NewPack” was added): 

 

 

5.10 How do I modify service assignments at the Group level? 

Just go to Group >  Modify > Service Assignments and add/remove the desired services, saving when you’re 
done:  
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5.11 How do I delete a Group? 

Just go to Group > Delete > Group and select the Group you’d like to delete:  

 

 

5.12 How do I delete a Department? 

This follows a process very similar to the one above; just select Department instead of Group. 

 

5.13 How do I delete a Trunk Group? 

Just go to Group > Delete > Trunk Group and select the Trunk Group you’d like to delete.  

 

 

5.14 How do I delete a Shared Device? 

This item is very similar to the above just select Group > Delete > Shared Device  and select the device you want 
to delete.  
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5.15 How do I delete TN’s from the Group? 

You can select this item by going to Group > Delete > Numbers. Then you select via checkbox the numbers you 
want to delete. Once you indicate the numbers you can optionally indicate that you’d like to delete them from the 
Enterprise as well:  

 

Note: it is not generally necessary to do this as the User delete routine allows for the complete removal of TN’s 
from the system. 

 

5.16 How do I delete virtual users? 

Go to Group > Delete > and select the type of Virtual User you’d like to delete. Then select the specific instance 
you’d like to delete.   
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6 Users 

6.1 What are the different ways I can add users? 

You can add users either through an Excel site survey or a user add wizard online. Generally speaking, the Excel 
site survey is used when the operator is selling IP PBX/Centrex to larger offices. The operator and the customer 
work through the details of the desired configuration in advance, recording the parameters of interest in the site 
survey (device type, phone number, service assignments, etc.). The wizard is used when the deployment model 
for IP PBX/Centrex involves very basic configurations that are customized on site and is also very common for 
business trunking and business lines. The following screen shot shows the available options:  

 

 

6.2 How does user provisioning relate to visual device management? 

The following diagram describes the VDM process:  

 

What’s important is to make sure that the right device type is provisioned and (optionally) the device model.  
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6.3 How does the site survey work? 

The following diagram illustrates the process:  

 

You can create whatever sheets you want in the site survey. The key thing is that they map values back to the 
sheet userAdd.I, and that that sheet is left 100% unchanged. Loki Provisioning will read values from that sheet 
during upload.  

 

6.4 How do I maintain the site survey? 

You maintain the site survey by way of simple Excel formulas. For example, the following formula appears in 
column E of useradd.I sheet in the Phone Number column:  

=IF('Station Review'!I30="", "", 'Station Review'!I30) 

What that formula says is “Get the phone number from cell I30 on the Station Review sheet (which is the order 
entry sheet) but if it’s blank, then just leave this cell blank.” 

The best introduction to the site survey is hands-on, and the site survey itself has a tab called ‘Notes’ that 
describes it and how to get around.  

 

6.4.1 How do I get the site survey? 

Just go to the tab ‘Users’, roll over the button ‘Add’ and select the option ‘by site survey’. You’ll then see a link 
‘download site survey’. 

 

6.5 How do I use the various columns in the site survey? What do they mean? 

Generally, you’ll create a “front end” sheet that just exposes the values you want in the way that you want. These 
then map to the Loki sheet. This has a couple of advantages: a) it keeps users from changing the format of the 
primary UserAdd sheet, which will cause Loki to fail b) it allows you to reduce the amount of things in the sheet, 
simplifying things for your customer-facing teams.  

The following table describes the columns and valid value for them:  

Item Description 

Index This is a locally significant index for organizing lines 

Number Mgmt. 
This refers to the various methods of placing numbers in the system; see section 
herein on TN Management.  
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Phone Number 
This is the phone number, which must be entered in as 10 digits with no additional 
characters.  

Extension  
This is the extension which must match the configured Group extension length 
and have no additional characters.  

UserID This is the BroadWorks userID that identifies the account. 

Calling Line ID 
This is the configurable calling line ID, which is only applicable if configurable 
calling line ID is enabled on the system.  

CLID First Name 
This is the user’s calling line ID first name. If this is left blank, the user’s first name 
will be used. 

CLID Last Name 
This is the user’s calling line ID last name. If this is left blank, the user’s first name 
will be used. 

CLID Blocking This turns the calling line ID blocking service on/off. 

First Name This is the user’s first name.  

Last Name This is the user’s last name. 

Email 
This is the user’s email address. This must be provisioned for automatic password 
reset on Loki Portals to function properly.  

Department 
This is the user’s Department, which must be pre-created in the Group or 
Enterprise.  

Site Service 
This indicates that the user is a “virtual user” at the Group level, like an Auto 
Attendant or Hunt Group. See the pre-configured drop down in Excel for a list of 
valid values.  

Service Pack I This is a service pack for the user, which must be pre-created in BroadWorks.  

Service Pack II 
This is a second service pack for the user, which must be pre-created in 
BroadWorks. This is often used for add-on or overlay services.  

Ala Carte I 
This is an individual service assignment for the user. This must match exactly the 
service’s name in BroadWorks.  

Ala Carte II ditto 

Ala Carte III ditto 

Ala Carte IV ditto 

Ala Carte V ditto 

Voicemail? 

This is a voicemail override. If the user has the Voice Messaging User service and 
this field is blank, the service will be set to on and a message store account 
created (assuming the message store interface is configured). If the field is set to 
Yes and a user does not have Voice Messaging User, the service will be assigned 
and a message store account configured. If the service is set to No and the Voice 
Messaging User is assigned, the service will be set to off and no message store 
account created.  

Voicemail Xfer on 0 This sets the number of extension for out-dialling from voice messaging.  

Email for CC 
This sets the cc address for voice messaging user- where the user will receive a 
.wav file of their voicemail.  

CF No Answer # 
This sets the call forward no answer destination. CFNA must be assigned to the 
user.  
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CF No Reach # 
This sets the call forward no answer destination. CFNR must be assigned to the 
user. 

SCA I 

This sets a shared call appearance- this must be added to the row of the 
monitoring/shared-to party. For example, if you are the exec and I am the admin, 
your userId would go in this column on the row that describes my account. The 
exec/sharing party must have the shared call appearance assigned.  

SCA II ditto 

SCA III ditto 

SCA IV ditto 

SCA V ditto 

Time Zone 
This is the user’s time zone. If blank, the user will have the Group’s time zone. This 
must match the list of available time zones in BroadWorks.  

Language  
This is the user’s language. If blank, the user will pick up the language for the 
group.  

Device Type 
This is the BroadWorks type, which must match the device type in BroadWorks. 
This exception is when user’s go on a shared/multi-user device. This device must 
be pre-created in the Group. See below on this item.  

Device Model 

This is the specific model of hardware (only required if you’re using visual device 
management). The valid values by manufacturer are:  

 Polycom 

o Polycom 650 

o Polycom 650 Ext1 

o Polycom 650 Ext2 

o Polycom 550 

o Polycom 450 

o Polycom 33x 

 Aastra 

o 57i 

Device.Name 
This is the name of the device. If a shared device, this must match the name of the 
existing device. If an IP phone, Loki will create a new device with this name.  

911 THIS FIELD IS DEPRECATED AND DOES NOTHING 

Trunk Group 
This is the name of the user’s trunk group, if applicable. The trunk group must be-
pre-created in BroadWorks.  

BWA 
This sets the BroadWorks Anywhere number for the user. BroadWorks Anywhere 
must be assigned to the user. 

Alt # TN Mgmt. I 
Number management routine for the first Alternate Number. The “port no temp” 
and (none)/blank routines are supported. 

Alt. # I 
This sets the first alternate number to assign to the user. Alternate Numbers must 
be assigned to the user. 

Alt # TN Mgmt. II 
Number management routine for the second Alternate Number. The “port no 
temp” and (none)/blank routines are supported. 

Alt. # II 
This sets the second alternate number to assign to the user. Alternate Numbers 
must be assigned to the user. 
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Alt # TN Mgmt. III 
Number management routine for the third Alternate Number. The “port no temp” 
and (none)/blank routines are supported. 

Alt. # IIII 
This sets the third alternate number to assign to the user. Alternate Numbers must 
be assigned to the user. 

UserOriginating-Group These fields map to the outgoing calling plan values in BroadWorks.  

UserOriginating-Local see above 

UserOriginating-TF see above 

UserOriginating-Toll see above 

UserOriginating-Internat’l see above 

UserOriginating-Operator 
Assisted 

see above 

UserOriginating-Directory 
Assistance 

see above 

UserOriginating-Special 
Services (700) 

see above 

UserOriginating-Premium 
Services (900 Call) 

see above 

UserOriginating-Premium 
Services (976 Call) 

see above 

UserTransfering-Group see above 

UserTransfering-Local see above 

UserTransfering-TF see above 

UserTransfering-Toll see above 

UserTransfering-Internat’l see above 

UserTransfering-Operator 
Assisted 

see above 

UserTransfering-Directory 
Assistance 

see above 

UserTransfering-Special 
Services (700) 

see above 

UserTransfering-Premium 
Services (900 Call) 

see above 

UserTransfering-Premium 
Services (976 Call) 

see above 

 

6.6 How do I add hosted IP Centrex subscribers using the site survey? 

These are added by way of the site survey or the web based bulk add interface. You can download the site 
survey from Loki on any screen. See the demo above for an overall review of adding users with the site survey. 
The particular fields of importance are these:  
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Make sure that the correct device type is selected, that the device has a unique name (the spreadsheet itself has 
a formula to ensure a unique name, but you can use whatever convention you like). The MAC address is optional: 
you can add it when you create the user or fill it in later with the MAC Update Page for just in time device 
provisioning. Trunk Group should, of course, be blank. 

 

6.7 How do I add business line (integrated access) subscribers using the site survey? 

In this case, the Device Type should always be set to “(Shared IAD)”. MAC address and Trunk Group should be 
blank. 

 

 

6.8 How do I add business trunking (integrated access) subscribers using the site survey? 

In this case, all fields should be blank except for the Trunk Group field. This should match whatever naming 
convention has been specified in Loki for trunk group creation. The default is to use the TN of the Trunk Group. 

 

 

6.9 How do I add users using the bulk add wizard? 

Navigate to Users > Add > by Wizard. There are six steps in the process:  

 select type of add: IP Centrex, Business Line, or Trunking 

 select device (trunk group) 

 add bulk inputs: numbers and service type 

 refine bulk inputs: as needed you can change the inputs for the individual User accounts 

 validate: this is the standard Loki validation 

 success (error) page: final success with secure credentials 

 

6.9.1 Select Type of Add 

The screen shot below shows this stage in the wizard; just select the type of add you want:  

Device.Type Device.Name Device.MAC Trunk Group

Polycom Soundpoint IP 601 PCOM6010001 ffffaaaa0001

Device.Type Device.Name Device.MAC Trunk Group

(Shared IAD) AT924Grp11011

Device.Type Device.Name Device.MAC Trunk Group

9124561234
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6.9.2 Select Device (Trunk Group) 

The screen shot below shows this second stage in the wizard. In the previous step we selected Business Line so 
we see a list of the shared IAD’s in the Group. If we had selecting Trunking we’d see Trunk Groups, and if we’d 
select IP Centrex, we’d select a default device type for our Users. Note: you can create either a Shared Device or 
Trunk Group at this point if you don’t have one.  

 

6.9.3 Add Bulk Inputs 

At this point you specify the TN Management Routine, TN’s, and/or extensions. Note: the Extensions inputs are 
only for creating extension-only Users (all Users you create will have extensions = the last n digits of their number 
where n is the default extension length in the Group). You can also set calling line ID here and designated Service 
Packs and/or ala carte Services. If you want voicemail enabled for these users, you can select it here. 
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6.9.4 Refine Bulk Inputs 

At this point you can refine the inputs for the individual Users you’re about to create. For example, you could add 
an ala carte Service:  

 

 



 

 

PROPRIETARY & CONFIDENTIAL  48 of 52 

 

6.9.5 Validate 

At this point you can refine the inputs for the individual Users you’re about to create. For example, you could add 
an ala carte Service:  

This is the standard Loki validation phase:  

 

 

6.9.6 Success (Error) 

At this point you’ll see the standard success/failure page including the Users’ secure credentials. 

 

6.10 How do I use the troubleshooting interface? 

You can navigate to the troubleshooting page by selecting a User in the supernav (it’s the default page) or by 
going to User > Modify > Troubleshooting.  

The page has four main areas, each described below. Note: you can also link to the User’s detailed profile in Loki 
Portals using the “Detailed Configuration” link at the top of the page or the “Modify User” link to change the 
User’s number, etc.  

  

6.10.1 Password Reset 

This allows you to reset the User’s password or voice portal pass code.  

6.10.2 Device Management 

The allows you to see whether the User has a valid SIP registration, and, if not, ping the User’s device or public 
interface. 

You can see these two items below.  
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6.10.3 Service Management 

This screen essentially allows you to see whether a User has their phone forwarded or otherwise diverted, and, if 
they do, reset that so you can verify normal inbound calling. Just use the “Reset All” button to initiate a reset. (see 
next screen shot) 

 

6.10.4 Virtual Translations and Routing 

This item allows you to verify translations and routing. Just add the destination dial string and you’ll see the vtr 
output from the BSFT Network Server.  
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6.10.5 Voice Message Store 

This allows you to update the User’s messaging settings. 
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6.11 How do I use the Parameters Maintenance interface? 

Navigate to Users > Modify > Parameters Maintenance. This interface allows you to perform bulk modifies around 
specific User parameters. For example, in the screen below we found all users with Voice Messaging and can 
now set the Transfer to 0 option to True and direct it to a specific destination:  

 

This is available for the following parameters:  

 Transfer on 0 

 Voice Portal Calling 

 Calling Line ID Delivery Blocking 

 Calling Line ID Phone Number 

 Disaster Redirect 

 Outgoing Calling Plan 

 Calling Name Retrieval 

 

6.12 How do I use User bulk delete interface? 

Navigate to User > Delete > Users. You’ll see the screen below:  
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Select the Users of interest and they’ll be delete from BroadWorks and (if supported) the message store. Note: 
this will not delete the Users’ device or numbers.  

 

6.13 Can I change a user’s Calling Line ID Number? 

You can edit a user’s Calling Line ID Number via the User Modify page or by using Parameters Maintenance. 

Note that in Loki Provisioning, it is possible to set or update a user’s Calling Line ID Number regardless of the Call 

Processing Policies configuration in BroadWorks. It is Leonid’s understanding that this will not affect the actual 

CLID presentation on outgoing calls unless the BroadWorks configuration is set to enable use of configurable 

CLID for that user (e.g. by selecting “Use configurable CLID for Calling Line Identity” in the applicable Enterprise, 

Group or User Call Processing Policies, or via the AS CLI). This is based on the information available in the 

BroadWorks document “Calling Line ID Enhancements Feature Description (R16)”. Under all circumstances, the 

operator must verify the CLID presentation via end to end testing on their particular network to ensure the 

desired behavior.  

 


